Bosch Rexroth is the leading manufacturer of Drive & Control technologies. It has expert know-how of the latest technical trends and innovations, along with the best practical training methods.
# TABLE OF CONTENTS

## CLASSROOM COURSES

<table>
<thead>
<tr>
<th>Course #</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>#10100</td>
<td>SMC Configuration, Programming &amp; Troubleshooting</td>
<td>5</td>
</tr>
<tr>
<td>#107</td>
<td>DIA04 Digital Servo Drives</td>
<td>6</td>
</tr>
<tr>
<td>#108</td>
<td>ECODrive III Basic Servo Drive</td>
<td>7</td>
</tr>
<tr>
<td>#1110</td>
<td>IndraDrive Basic Servo Drive</td>
<td>8</td>
</tr>
<tr>
<td>#1130</td>
<td>IndraDrive Integrated Safety Technology</td>
<td>9</td>
</tr>
<tr>
<td>#1140</td>
<td>IndraDrive Motion-Logic Single Axis (MLD-S)</td>
<td>10</td>
</tr>
<tr>
<td>#1150</td>
<td>IndraDrive Motion-Logic Multiple Axes (MLD-M)</td>
<td>11</td>
</tr>
<tr>
<td>#1210</td>
<td>IndraDrive Mi Gen1 Basic Servo Drive</td>
<td>12</td>
</tr>
<tr>
<td>#1211</td>
<td>IndraDrive Mi Gen2 Basic Servo Drive</td>
<td>13</td>
</tr>
<tr>
<td>#1310</td>
<td>IndraDrive Cs Basic Servo Drive</td>
<td>14</td>
</tr>
<tr>
<td>#150</td>
<td>Synax ELS Motion Versions 4–8</td>
<td>15</td>
</tr>
<tr>
<td>#155</td>
<td>Synax ELS Motion Versions 11–13 without IndraLogic</td>
<td>16</td>
</tr>
<tr>
<td>#156</td>
<td>Synax ELS Motion Versions 11–13 with IndraLogic</td>
<td>17</td>
</tr>
<tr>
<td>#2100</td>
<td>IndraMotion MLC with L40.2 Control Maintenance &amp; Troubleshooting</td>
<td>18</td>
</tr>
<tr>
<td>#2110</td>
<td>IndraMotion MLC with L40 Control (Programming Level 1)</td>
<td>19</td>
</tr>
<tr>
<td>#2200</td>
<td>IndraMotion MLC with L25/45/65 Control</td>
<td>20</td>
</tr>
<tr>
<td>#2210</td>
<td>IndraMotion MLC with L25/45/65 Control (Programming Level 1)</td>
<td>21</td>
</tr>
<tr>
<td>#2220</td>
<td>IndraMotion MLC Control (Programming Level 2)</td>
<td>22</td>
</tr>
<tr>
<td>#3000</td>
<td>IndraLogic Gen1 Basics</td>
<td>23</td>
</tr>
<tr>
<td>#3010</td>
<td>IndraLogic Gen1 Program Basics</td>
<td>24</td>
</tr>
<tr>
<td>#3020</td>
<td>IndraLogic Gen1 Advanced Programming</td>
<td>25</td>
</tr>
<tr>
<td>#3100</td>
<td>IndraLogic Gen2 Program Basics</td>
<td>26</td>
</tr>
<tr>
<td>#3110</td>
<td>IndraLogic Gen2 Basic Programming</td>
<td>27</td>
</tr>
<tr>
<td>#3120</td>
<td>IndraLogic Gen2 Advanced Programming</td>
<td>28</td>
</tr>
<tr>
<td>#4110</td>
<td>MTX Maintenance &amp; Troubleshooting</td>
<td>29</td>
</tr>
<tr>
<td>#6100</td>
<td>PSI Welding Control</td>
<td>30</td>
</tr>
<tr>
<td>#7100</td>
<td>VI Composer with VCP Terminals</td>
<td>31</td>
</tr>
<tr>
<td>#7200</td>
<td>Bosch WinStudio Version 6</td>
<td>32</td>
</tr>
<tr>
<td>#7210</td>
<td>Bosch WinStudio Version 7</td>
<td>33</td>
</tr>
</tbody>
</table>
### TABLE OF CONTENTS (continued)

#### ONLINE COURSES

<table>
<thead>
<tr>
<th>Course #</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>80150</td>
<td>Synax Versions 4–8 with SynTop Version 6</td>
<td>34</td>
</tr>
<tr>
<td>81110</td>
<td>IndraDrive M/C Maintenance &amp; Troubleshooting</td>
<td>35</td>
</tr>
<tr>
<td>83010</td>
<td>IndraLogic Gen1 Basic Programming</td>
<td>36</td>
</tr>
<tr>
<td>83110</td>
<td>IndraLogic Gen2 Basic</td>
<td>37</td>
</tr>
<tr>
<td>83120</td>
<td>IndraLogic Gen2 Advanced Programming</td>
<td>38</td>
</tr>
</tbody>
</table>

#### RECORDED COURSES

<table>
<thead>
<tr>
<th>Course #</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8003</td>
<td>IndraDrive Digital Servo Drive Basics</td>
<td>39</td>
</tr>
<tr>
<td>8010</td>
<td>IndraLogic Basic</td>
<td>40</td>
</tr>
<tr>
<td>8020</td>
<td>IndraLogic Basic Programming</td>
<td>41</td>
</tr>
<tr>
<td>8107</td>
<td>DIAX04 Digital Servo Drives</td>
<td>42</td>
</tr>
<tr>
<td>8108</td>
<td>DKC Digital Servo Drive Basics</td>
<td>43</td>
</tr>
<tr>
<td>8190</td>
<td>DriveTop Software</td>
<td>44</td>
</tr>
<tr>
<td>8211</td>
<td>IndraDrive Mi Gen 2 Digital Servo Drive Basics</td>
<td>45</td>
</tr>
<tr>
<td>8343</td>
<td>Visual Motion Basics for Versions 10–11</td>
<td>46</td>
</tr>
</tbody>
</table>
Course #10100
SMC Configuration, Programming & Troubleshooting

PREREQUISITES:
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth’s SMC-Editor software (version 12 or newer) installed on their computer.
   
   *A loaner laptop can be provided by Bosch Rexroth, if needed.*

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician
▶ Operators

TUITION: $1000.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Relate the system connections to their application
▶ Identify all hardware associated with the system
▶ Identify different versions of Firmware
▶ Understand the uses of the SMC-Editor
▶ Understand the function of control and drive parameters
▶ Set up, program, and operate the system
▶ Set up and manage the VCP08 visualization panel
▶ Execute Commands by way of the VCP08 Operator Panel
▶ Identify SMC Diagnostic Messages

TRAINING CLASS LENGTH: 3 Days

This course provides familiarization with the system configuration, functions, and programming of Bosch Rexroth’s Sequential Motion Control (SMC), based on the IndraDrive MLD-M architecture. This course uses the SMC-Editor software for programming and parameterization of the system, fault information, and system recognition of components. It also includes the use of the VCP08 Visualization panel for system operation, parameterization, and system monitoring and troubleshooting. Training is enhanced through class exercises designed to reinforce each aspect of the operation of the system.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
   https://boschrexroth-us-training.configio.com
Course #107  
DIA04 Digital Servo Drives

**PREREQUISITES:** No prerequisites required

**TARGET GROUP:**
- Engineering Technician
- Maintenance Technician
- Electrician Operators

**TUITION:** $670.00 per student (Lunch included)

**WHAT YOU WILL LEARN:**
- Servo Drive Principals
  - Control Loops
  - PWM
  - Motors
  - Encoders
  - Resolvers
- Drive System Product Overview
- DriveTop Software
- Practical Exercises
- Servo Drive Modes of Operation

**TRAINING CLASS LENGTH:** 2 Days

This course covers theory of operations, functions of major components, SERCOS and electrical interface, diagnostics and practical troubleshooting. Programmable parameters configured using DriveTop pc software with SERCANS interface module.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #108
ECODrive III Basic Servo Drive

PREREQUISITES: No prerequisites required

TARGET GROUP:
- Engineering Technician
- Maintenance Technician
- Electrician Operators

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
- Understand the control loops in a servo drive
- Understand the gains used in a servo drive
- Understand basic motor and feedback theory
- Understand SERCOS Communications
- Relate the connectors and the connections on the ECODrive III to their application
- Identify all of the ECODrive III Interfaces
- Identify different versions of Firmware
- Understand Firmware compatibility with interfaces
- Understand the Technical Information of ECODrive III
- Identification of Bosch Rexroth Servo and Spindle motors
- Identify all additional modules associated with the ECODrive III
- Identify Error Codes on the ECODrive III
- Understand the function of important Standard and Product Specific Parameters
- Communicate to the drive with DriveTop™
- Setup and operation of drive in three basic modes
- Setup of Measuring Systems

TRAINING CLASS LENGTH: 2 Days

This two-day course of Bosch Rexroth’s ECODrive III Maintenance Course provides for familiarization with the Basic Servo Drive Theory, Motor and Encoder Theory, SERCOS, Drive Connections and Basic Operating Modes of the ECODrive III. This course will also cover the use of DriveTop™ with regards to parameterization of drives, system and fault information and system recognition of components.

For more information contact us at:  1(847) 645-4061
For immediate assistance call:  1-800-REXROTH (24 Hours/Day)
Full course agenda click here:  Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #1110
IndraDrive Basic Servo Drive

PREREQUISITES: No prerequisites required

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operators

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Relate the connections on the servo drive to their application
▶ Execute Commands by way of the Operator Panel
▶ Identify different versions of Firmware
▶ Identify Bosch Rexroth Servo and Spindle motors
▶ Identify IndraDrive Diagnostic Messages
▶ Identify all hardware associated with the drive
▶ Identify Diagnostic messages created by the drive
▶ Understand the function of important Standard and Product Specific Parameters
▶ Communicate to the drive using DriveTop™/IndraWorks™
▶ Set up and operate drive
▶ Set up and manage oscilloscope utility
▶ Set absolute zero and machine zero with or without offset

TRAINING CLASS LENGTH: 2 Days

This two-day course provides familiarization with the electrical connections, functions, and various operating modes of Bosch Rexroth’s IndraDrive digital servo drive. This course also covers the use of DriveTop™/IndraWorks™ software for parameterization of drives, system and fault information, and system recognition of components. Training is enhanced through class exercises designed to reinforce each aspect of the operation of the drive.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #1130
IndraDrive Integrated Safety Technology

PREREQUISITES:
▶ Course #1110 IndraDrive Basic Servo Drive
  OR Online Course #81110 IndraDrive Basic Servo Drive

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operators

TUITION: $335.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Understand the requirements and necessities of Safety Technology
▶ Understand how the technology applies to the drive
▶ Set up the safety interface between the drive and the process control
▶ Review and verify the safety parameters in the drive
▶ Identify Safety Diagnostic messages created by the drive
▶ Understand the effect the technology has on servo drive replacement
▶ Replace a defective drive unit and re-enter the correct safety parameters
▶ Concepts of Safety Technology: Machine Safety, Risk Analysis, Conformity Procedure, Standards
▶ Risk graphs and risk assessment according to DIN Standards
▶ Safety of Machinery
▶ IndraDrive Safety Technology
▶ Safety-On-Board
▶ Safety Related Motion, Inputs and Outputs

TRAINING CLASS LENGTH: 1 Day

This one-day course covers the use of the Integrated Safety Technology function available in the Bosch Rexroth IndraDrive Digital Servo Drive. This course expands on the knowledge gained in the #1110 course. The setup and operation of the function is covered and performed in the drive. The history and current machine requirements of the technology are discussed to help the student further understand the operation of the function, and how it relates to various other machine/process functions.

Training is enhanced with the use of class exercises designed to reinforce each aspect of the operation of the function. Class exercises use Bosch Rexroth’s IndraWorks™ software communicating through the drive’s serial interface for the control and operation of the drive.
Course #1140
IndraDrive Motion-Logic Single Axis (MLD-S)

PREREQUISITES:
▶ Course #1110 IndraDrive Basic Servo Drive OR Online Course #81110 IndraDrive Basic Servo Drive
▶ Course #3000 IndraLogic Program Basics OR #3010 IndraLogic Control Basics OR Recorded Course #8010 IndraLogic Gen1 Basics
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraWorks software (version 7V12 or newer) already installed onto the computer prior to taking the course.
A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operators

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Review IndraDrive hardware & FW as it relates to MLD-S operation
▶ Create an IndraWorks Project for MLD-S operation
▶ Understand the PLC-Drive data structure
▶ Programming PLC operation within the drive
▶ Understand PLC and drive task timing
▶ Understand the different data channels available
▶ Diagnose and Troubleshoot PLC and drive operation
▶ Saving and archiving IndraWorks project data
▶ IndraDrive Servo Drive and IndraWorks overview
▶ Motion-Logic drive data structure
▶ Motion-Logic drive programming

TRAINING CLASS LENGTH: 2 Days

This two-day course covers the Motion-Logic function in the Bosch Rexroth IndraDrive Digital Servo Drive. This course expands on the knowledge gained in the #1110 course. The setup, parameterization, and operation of the function is covered and performed in the drive. The student will learn the full capability of the integrated PLC, task timing, system IO capabilities, expansion options, and programming. The student will learn the different methods available for interfacing with hierarchical devices and HMIs.

Students will write logic programs for axis IO operation. PLCopen Motion Function block programs will be used to control and monitor axis operation. Class exercises use Bosch Rexroth’s IndraWorks™ software communicating through the drive’s serial interface for the control and operation of the drive. The IndraLogic Visualization tool will be used to simulate an HMI data interface and to control and monitor program execution and axis operation.
Course #1150
IndraDrive Motion-Logic Multiple Axes (MLD-M)

PREREQUISITES:
▶ Course #1110 IndraDrive Basic Servo Drive OR Online Course #81110 IndraDrive Basic Servo Drive
▶ Course #1140 IndraDrive Motion-Logic in Drive, Single Axis
▶ Course #3000 IndraLogic Program Basics OR #3010 IndraLogic Control Basics OR Recorded Course #8010 IndraLogic Gen1 Basics

A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operators

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Understand the concept and operation of the PLC within the IndraDrive
▶ Create an entire IndraDrive Motion-Logic Project within IndraWorks
▶ Understand the operation of the CCD Control Module
▶ Diagnose and troubleshoot program & drive operation
▶ Understand the various data types and their uses
▶ Understand the parameter structure used for MLD-M operation
▶ Understand PLC and drive cycle times
▶ Understand programming within the Motion-Logic environment

TRAINING CLASS LENGTH: 2 Days

This two-day course covers the Motion-Logic function through the CCD command module in the Bosch Rexroth IndraDrive Digital Servo Drive, as it applies to controlling multiple axes. This course expands on the knowledge gained in both the #1110 and #1140 courses. The setup, parameterization, and operation of the function is covered and performed in the integrated CCD option module and in the drives. The student will learn the full capability of the integrated PLC, task timing, system IO capabilities, expansion options, and programming. SERCOS III communication is introduced along with the different methods available for interfacing/communicating with multiple servo drives, hierarchal devices, and HMI s.

Students will write logic programs for multiple axes IO operations. PLCopen Motion Function block programs will be used to control and monitor axes operation and motion. Class exercises use Bosch Rexroth's IndraWorks™ software communicating through the drive's Ethernet interface for the control and operation of the drives. The IndraLogic Visualization tool will be used to simulate an HMI data interface and to control and monitor program execution and axes operation.
Course #1210
IndraDrive Mi Gen1 Basic Servo Drive

**PREREQUISITES:** No prerequisites required

**TARGET GROUP:**
▶ Engineering Technician  
▶ Maintenance Technician  
▶ Electrician Operators

**TUITION:** $670.00 per student (Lunch included)

**WHAT YOU WILL LEARN:**
▶ Relate the connections on the servo drive to their application
▶ Execute commands by way of the Operator Panel
▶ Identify different versions of Firmware
▶ Identify Bosch Rexroth Servo and Spindle motors
▶ Identify IndraDrive diagnostic messages
▶ Identify all hardware associated with the drive
▶ Identify diagnostic messages created by the drive
▶ Understand the function of important Standard and Product Specific Parameters
▶ Communicate to the drive using DriveTop™ / IndraWorks™
▶ Set up and operate drive
▶ Set up and manage oscilloscope utility
▶ Set absolute zero and machine zero with or without offset

**TRAINING CLASS LENGTH:** 2 Days

This two-day course provides familiarization with the electrical connections, functions, and various operating modes of Bosch Rexroth’s IndraDrive Mi digital servo drive. This course also covers the use of IndraWorks™ software for parameterization of drives, system and fault information, and system recognition of components. Training is enhanced through class exercises designed to reinforce each aspect of the operation of the drive.

For more information contact us at:  **1(847) 645-4061**  
For immediate assistance call: **1-800-REXROTH (24 Hours/Day)**  
Full course agenda click here: **Bosch Rexroth Training Calendar**  
**https://boschrexroth-us-training.configio.com**
Course #1211
IndraDrive Mi Gen2 Basic Servo Drive

PREREQUISITES: No prerequisites required

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operators

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Relate the connections on the servo drive to their application
▶ Identify different versions of Firmware
▶ Identify IndraDrive diagnostic messages
▶ Identify all hardware associated with the drive
▶ Identify Diagnostic LEDs on the KCU and the drive
▶ Understand the function of important Standard and Product Specific Parameters
▶ Communicate to the drive using IndraWorks™ software
▶ Set up and operate drive
▶ Set up and manage oscilloscope utility
▶ Set absolute zero and machine zero with or without offset

TRAINING CLASS LENGTH: 2 Days

This two-day course provides familiarization with the electrical connections, functions, and various operating modes of Bosch Rexroth's IndraDrive Mi Gen2 digital servo drive. This course also covers the use of Bosch Rexroth's IndraWorks™ software for parameterization of drives, system and fault information, and system recognition of components. Training is enhanced through class exercises designed to reinforce each aspect of the operation of the drive.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #1310
IndraDrive Cs Basic Servo Drive

PREREQUISITES: No prerequisites required

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operators

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Relate the connections on the servo drive to their application
▶ Execute commands by way of the Operator Panel
▶ Identify different versions of Firmware
▶ Identify Bosch Rexroth Servo and Spindle motors
▶ Identify IndraDrive diagnostic messages
▶ Identify all hardware associated with the drive
▶ Identify diagnostic messages created by the drive
▶ Understand the function of important Standard and Product Specific Parameters
▶ Communicate to the drive using IndraWorks™
▶ Set up and operate drive
▶ Set up and manage oscilloscope utility
▶ Set absolute zero and machine zero with or without offset

TRAINING CLASS LENGTH: 2 Days

This two-day course provides familiarization with the electrical connections, functions, and various operating modes of Bosch Rexroth's IndraDrive Cs digital servo drive. This course also covers the use of Bosch Rexroth's IndraWorks™ software for parameterization of drives, system and fault information, and system recognition of components. Training is enhanced through class exercises designed to reinforce each aspect of the operation of the drive.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #150
Synax ELS Motion Versions 4–8

PREREQUISITES:
- Student must have a basic understanding of the Microsoft Windows™ computer operating system
- Student should have participated in at least one of the Bosch Rexroth Digital Servo Drive training courses
- If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth SynTop software (version 6) installed on the computer.
  A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
- Engineering Technician
- Maintenance Technician
- Electrician Operators

TUITION: $1000.00 per student (Lunch included)

WHAT YOU WILL LEARN:
- Understand the concept of Electronic Line Shafting
- Apply the concepts of Electronic Line Shafting to their application
- Understand the concepts of a Real and Virtual ELS Master
- Understand the types of synchronization available in a Synax System
- Define the typical components used in a Synax System, and their functions
- Commission the CLC (versions 5 & 6)/PPC (version 8) Motion Control for a Synax process
- Commission the Digital Servo Drives for a Synax process
- Create an I/O structure for a Synax process
- Create the data mapping for a Synax process
- Apply system jogging capabilities to a Synax process
- Modify real-time adaptation parameters to fine-tune a Synax process
- Use the SynTop and IndraLogic software tools for commissioning and troubleshooting
- Back-up system information for storage and retrieval

TRAINING CLASS LENGTH: 3 Days

This three-day course of Bosch Rexroth’s Synax Motion and Logic Control System, versions 4 through 8, provides for familiarization with Bosch Rexroth’s Electronic Line Shafting technology. The student will gain a thorough understanding of this technology and how it applies to their manufacturing process. The functions of the CLC / PPC Synax Motion Control and IO mapping system, along with configuration and process adaptation, will be covered using Bosch Rexroth’s SynTop version 6 software tool. The student will work through the complete configuration and operation of a system, including the use of real-time adaptation parameters and system IO, for the control of an Electronic Line Shafting process.
Course #155
Synax ELS Motion Versions 11–13 without IndraLogic

PREREQUISITES:
▶ Student must have a basic understanding of the Microsoft Windows™ computer operating system
▶ Student should have participated in at least one of the Bosch Rexroth Digital Servo Drive training courses
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth SynTop software (version 11 or newer) installed on the computer. A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operators

TUITION: $1000.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Understand the concept of Electronic Line Shafting
▶ Apply the concepts of Electronic Line Shafting to their application
▶ Understand the concepts of a Real and Virtual ELS Master
▶ Understand the types of synchronization available in a Synax System
▶ Define the typical components used in a Synax System, and their functions
▶ Commission the PPC Motion Control for a Synax process
▶ Commission the Digital Servo Drives for a Synax process
▶ Commission the IndraLogic PLC for a Synax process
▶ Create an I/O structure for a Synax process
▶ Create the data mapping for a Synax process
▶ Apply system jogging capabilities to a Synax process
▶ Modify real-time adaptation parameters to fine-tune a Synax process
▶ Use the SynTop and IndraLogic software tools for commissioning and troubleshooting
▶ Back-up system information for storage and retrieval

TRAINING CLASS LENGTH: 3 Days

This three-day course of Bosch Rexroth’s Synax Motion and Logic Control System, versions 11, 12, & 13, provides for familiarization with Bosch Rexroth’s Electronic Line Shafting technology. The student will gain a thorough understanding of this technology and how it applies to their manufacturing process. The functions of the PPC Synax Motion Control and Logic system, along with configuration and process adaptation, will be covered using Bosch Rexroth’s SynTop and IndraLogic software tools. The student will work through the maintenance and troubleshooting of a system, including the use of real-time adaptation parameters and system IO, for the control of an Electronic Line Shafting process.
Course #156
Synax ELS Motion Versions 11–13 with IndraLogic

PREREQUISITES:
▶ Student must have a basic understanding of the Microsoft Windows™ computer operating system
▶ Student should have participated in at least one of the Bosch Rexroth Digital Servo Drive training courses
▶ Student should have attended one of the basic IndraLogic training classes to obtain a basic understanding of the Bosch Rexroth IndraLogic PLC environment
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth SynTop software (version 11 or newer) installed on the computer.
   *A loaner laptop can be provided by Bosch Rexroth, if needed.*

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operators

TUITION: $1,675.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Understand the concept of Electronic Line Shafting
▶ Apply the concepts of Electronic Line Shafting to their application
▶ Understand the concepts of a Real and Virtual ELS Master
▶ Understand the types of synchronization available in a Synax System
▶ Define the typical components used in a Synax System, and their functions
▶ Commission the PPC Motion Control for a Synax process
▶ Commission the Digital Servo Drives for a Synax process
▶ Commission the IndraLogic PLC for a Synax process
▶ Create an I/O structure for a Synax process
▶ Create the data mapping for a Synax process
▶ Apply system jogging capabilities to a Synax process
▶ Modify real-time adaptation parameters to fine-tune a Synax process
▶ Use the SynTop and IndraLogic software tools for commissioning and troubleshooting
▶ Back-up system information for storage and retrieval

TRAINING CLASS LENGTH: 5 Days

This five-day course of Bosch Rexroth’s Synax Motion and Logic Control System, versions 11, 12, & 13, provides for familiarization with Bosch Rexroth’s Electronic Line Shafting technology. The student will gain a thorough understanding of this technology and how it applies to their manufacturing process. The functions of the PPC Synax Motion Control and Logic system, along with configuration and process adaptation, will be covered using Bosch Rexroth’s SynTop and IndraLogic software tools. The student will work through the complete configuration and operation of a system, including the use of real-time adaptation parameters and system IO, for the control of an Electronic Line Shafting process.
Course #2100
IndraMotion MLC with L40.2 Control
Maintenance & Troubleshooting

PREREQUISITES:
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraWorks software (version 7V12 or newer) installed on the computer.
A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operators

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Relate the connections on the L40 control to their application
▶ Create a new Project, or edit the various components in an existing Project
▶ Install and/or modify existing I/O configurations
▶ Add peripheral devices to the system, as required
▶ Understand the relationships between the control and other connected devices
▶ Understand the various communication methods used to transfer data between the Motion Control, HMI, and Servo Drives
▶ Understand how servo drive motion is controlled and monitored
▶ Understand how to troubleshoot the system and its individual components

TRAINING CLASS LENGTH: 2 Days

This two-day course provides familiarization with the electrical connections, functions, and various operating modes of Bosch Rexroth’s IndraMotion series MLC control with IndraDrive Servo Drives. This course also covers the use of IndraWorks™ software for programming, parameterization, system and fault information, and system recognition of components. Training is enhanced through class exercises designed to reinforce each aspect and function of the system.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #2110
IndraMotion MLC with L40 Control (Programming Level 1)

PREREQUISITES:
▶ Course #2100 IndraMotion MLC with L40.2 Control
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraWorks software (version 7V12 or newer) installed on the computer.
  
  A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operators

TUITION: $1000.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Create a new Project, or edit the various components in an existing Project
▶ Program motion using multiple PLCopen supported languages
▶ Understand single axis and synchronized motion
▶ Understand Electronic Camming
▶ Understand the various communication methods used to transfer data between the Motion Control, HMI, and Servo Drives
▶ Understand how servo drive motion is controlled and monitored
▶ MLC Motion Programs
▶ Single Axis Motion
▶ Velocity Synchronization
▶ Phase Synchronization

TRAINING CLASS LENGTH: 3 Days

This three-day course provides familiarization with the programming of all types of motion available in the Bosch Rexroth IndraMotion series MLC control. This course uses IndraWorks™ software for programming, parameterization, and program monitoring. Training is enhanced through class exercises designed to reinforce each programming concept. The IndraLogic Visualization function is used for controlling program operation and for program monitoring.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #2200
IndraMotion MLC with L25/45/65 Control

PREREQUISITES:
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraWorks software (version 10V12 or newer) installed on the computer.
   *A loaner laptop can be provided by Bosch Rexroth, if needed.*

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operators

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Relate the connections on the MLC control to their application
▶ Create a new Project, or edit the various components in an existing Project
▶ Install and/or modify existing I/O configurations
▶ Add peripheral devices to the system, as required
▶ Understand the relationships between the control and other connected devices
▶ Understand the various communication methods used to transfer data between the Motion Control, HMI, and Servo Drives
▶ Understand how servo drive motion is controlled and monitored
▶ System Outline – Hardware & System Architecture
▶ IndraWorks Engineering for MLC
▶ IO Configuration
▶ IndraLogic and MLC Basics
▶ Data Archive & Restore
▶ MLC Error Handling
▶ IndraDrive Servo Drive

TRAINING CLASS LENGTH: 2 Days

This two-day course provides familiarization with the electrical connections, functions, and various operating modes of Bosch Rexroth’s IndraMotion series MLC control with IndraDrive Servo Drives. This course also covers the use of IndraWorks™ software for programming, parameterization, system and fault information, and system recognition of components. Training is enhanced through class exercises designed to reinforce each aspect and function of the system.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #2210
IndraMotion MLC with L25/45/65 Control (Programming Level 1)

PREREQUISITES:
▶ Course #2200 IndraMotion MLC with L25/45/65 Control
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraWorks software (version 10V12 or newer) installed on the computer. A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Controls Technician
▶ Controls Support Engineer

TUITION: $1000.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Create a new Project, or edit the various components in an existing Project
▶ Program motion using multiple PLCopen supported languages
▶ Understand single axis and synchronized motion
▶ Understand Electronic Camming, Electronic Motion Profiles, & FlexProfiles
▶ Understand the MLC Axis Interface and its uses
▶ Understand the various communication methods used to transfer data between the Motion Control, HMI, and Servo Drives
▶ Understand how servo drive motion is controlled and monitored

TRAINING CLASS LENGTH: 3 Days

This three-day course provides familiarization with the programming of all types of motion available in the Bosch Rexroth’s IndraMotion series MLC control. This course uses IndraWorks™ software for programming, parameterization, and program monitoring. Training is enhanced through class exercises designed to reinforce each programming concepts. The IndraLogic Visualization function is used for controlling program operation and for program monitoring.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #2220
IndraMotion MLC Control (Programming Level 2)

PREREQUISITES:
▶ Course #2210 IndraMotion MLC with L25/45/65 Control
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraWorks software (version 10V12 or newer) installed on the computer.
   A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Controls Technician
▶ Controls Support Engineer

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Create a new Project, or edit the various components in an existing Project
▶ Program motion using multiple PLCopen supported languages
▶ Understand the IMC Interface and its uses
▶ Understand the MLC C2C Link and its uses
▶ Understand UDP Socket communication
▶ Understand the Generic Application Template (GAT) and its uses
▶ Technology Functions

TRAINING CLASS LENGTH: 2 Days

This two-day course continues and expands on the programming knowledge gained in the #2110 course. This course uses IndraWorks™ software for programming, parameterization, and program monitoring. Training is enhanced through class exercises designed to reinforce each programming concepts. The IndraLogic Visualization function is used for controlling program operation and for program monitoring.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #3000
IndraLogic Gen1 Basics

PREREQUISITES:
▶ Students must have knowledge of the function, operation, and programming of PLCs.
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraLogic software installed on the computer.
   *A loaner laptop can be provided by Bosch Rexroth, if needed.*

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Understand PLCopen Fundamentals
▶ Create a Project
▶ Write programs in Structured Text, Function Block Diagram, Ladder Diagram, Instruction List, Sequential Function Chart, and Continuous Function Chart
▶ Understand IEC–Step–Action commands in Sequential Function Chart programming
▶ Use the Library Manager
▶ Build, run, stop, and edit programs
▶ Debug an IndraLogic program
▶ Understand fundamental data types – DINT, BOOL, WORD, STRING, etc.
▶ Understand variable types – Global, Retain, and Persistent, how to declare and how they are used in programs
▶ Understand jumping, and labels
▶ Assign task configurations, timing, and priorities to resources
▶ Use the Sample Trace function
▶ Save, import, and export project data

TRAINING CLASS LENGTH: 2 Days

This two-day course is designed to familiarize the new user to the IndraLogic Gen1 PLCopen programming environment. Subjects covered include program elements, task configurations, data types, variable types, program debug, and program monitoring. All supported languages will be covered, i.e., Structured Text, Ladder Diagram, Function Block Diagram, Sequential Function Chart, and Continuous Function Chart.

The students will be creating a project that uses all of the programming languages. This project will be run in a simulated environment that allows all programs to run on the computer without the need for any other hardware devices. The IndraLogic Visualization tool will be used to control, monitor, and troubleshoot the various programs.
Course #3010
IndraLogic Gen1 Program Basics

PREREQUISITES:
▶ Students must have knowledge of the function, operation, and programming of PLCs.
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraLogic software installed on the computer.
   A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $1000.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Understand PLCopen Logic specifications
▶ Select the proper hardware Targets
▶ Create a project, and operate within that project environment
▶ Learn how to Use the Library Manager
▶ Write and debug programs in Structured Text, Function Block Diagram, Ladder Diagram, Instruction List, and Sequential Function Chart
▶ Understand basic data types – DINT, BOOL, WORD, STRING, REAL, and more
▶ Understand and use various variable types – Global, System, and Local
▶ Understand Retain, Persistent, and Constant data
▶ Learn how to assign task configurations, timing, and priorities to resources
▶ Use the Sampling Trace function for diagnostic monitoring and troubleshooting
▶ Learn how to save, import and export project data
▶ Create process specific visualizations for monitoring and troubleshooting
▶ Network Installation
▶ IndraWorks I/O Configuration
▶ Program Upload/Download
▶ Export/Import Project Data
▶ Library Management
▶ Program Monitoring
▶ Data Back-up and Restore

TRAINING CLASS LENGTH: 3 Days

This three-day course is designed to give the IndraLogic user the tools necessary to develop their processes in the IndraLogic PLCopen programming environment. Subjects covered include project structure, library management and creation, device specific target settings, device specific PLC Configurations, task configuration, variable types, field buses, Function Block Motion programming, etc. Programming languages covered include Structured Text, Instruction List, Ladder Diagram, Function Block Diagram, and Sequential Function Chart. IndraLogic Visualizations will be created to control program operation and to simulate an HMI interface.
Course #3020
IndraLogic Gen1 Advanced Programming

PREREQUISITES:
▶ Course #3010 IndraLogic Gen1 Program Basics OR Online Course #83010 IndraLogic Gen1 Basic Programming (or have extensive knowledge in the use of advanced PLC data types, and a working knowledge of Structured Text programming).
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraLogic software installed on the computer.

A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Understand PLCopen Logic specifications
▶ Understand PLCopen project components
▶ Create a project, and operate within that project environment
▶ Learn how to Use the Library Manager
▶ Write and debug programs in Structured Text
▶ Understand basic data types – DINT, BOOL, WORD, STRING, REAL, and more
▶ Understand and use various variable types – Global, System, and Local
▶ Understand Retain, Persistent, and Constant data
▶ Convert between the various data types
▶ Work with String Variables and Manipulate the String Data
▶ Apply and Monitor Indirect Addressing for data retrieval
▶ Create, Open, Append, and Close Files within the PLC Program
▶ Use the Sampling Trace function for diagnostic monitoring and troubleshooting
▶ Learn how to save, import and export project data
▶ Create process specific visualizations for monitoring and troubleshooting

TRAINING CLASS LENGTH: 2 Days

This two-day course is designed to give the experienced IndraLogic user the tools necessary to further develop their processes. Using the exercises created in the #3010 class, the student will be adding additional data types to enhance process capabilities. The data types used will be Arrays, Data Structures, and Enumerations. The student will also be learning programming options for working with STRING and File data. The student will be creating one-, two-, and three-dimensional Arrays. These arrays will be populated and the data further processed using Data Structures. The programming language used will be Structured Text.
Course #3100
IndraLogic Gen2 Program Basics

PREREQUISITES:
▶ Students must have knowledge of the function, operation, and programming of PLCs.
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraLogic Gen2 or IndraWorks software (version 10 or newer) installed on the computer.

A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Understand PLCopen Fundamentals
▶ Create a Project
▶ Write programs in Structured Text, Function Block Diagram, Ladder Diagram, Instruction List, Sequential Function Chart, and Continuous Function Chart
▶ Understand IEC–Step–Action commands in Sequential Function Chart programming
▶ Use the Library Manager
▶ Build, run, stop, and edit programs
▶ Debug an IndraLogic program
▶ Understand fundamental data types – DINT, BOOL, WORD, STRING, etc.
▶ Understand variable types – Global, Retain, and Persistent, how to declare and how they are used in programs
▶ Understand jumping, and labels
▶ Assign task configurations, timing, and priorities to resources
▶ Use the Sample Trace function
▶ Save, import, and export project data

TRAINING CLASS LENGTH: 2 Days

This two-day course is designed to familiarize the new user to the IndraLogic Gen2 PLCopen programming environment. Subjects covered include program elements, task configurations, data types, variable types, program debug, and program monitoring. All supported languages will be covered, i.e., Structured Text, Ladder Diagram, Function Block Diagram, Sequential Function Chart, and Continuous Function Chart.

The students will be creating a project that uses all of the programming languages. This project will be run in a simulated environment that allows all programs to run on the computer without the need for any other hardware devices. The IndraLogic Visualization tool will be used to control, monitor, and troubleshoot the various programs.
Course #3110
IndraLogic Gen2 Basic Programming

PREREQUISITES:
▶ Students must have knowledge of the function, operation, and programming of PLCs.
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraLogic Gen2 software installed on the computer. A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $1000.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Understand PLCopen Logic specifications
▶ Select the proper hardware Targets
▶ Create a project, and operate within that project environment
▶ Learn how to Use the Library Manager
▶ Write and debug programs in Structured Text, Function Block Diagram, Ladder Diagram, Instruction List, and Sequential Function Chart
▶ Understand basic data types – DINT, BOOL, WORD, STRING, REAL, and more
▶ Understand and use various variable types – Global, System, and Local
▶ Understand Retain, Persistent, and Constant data
▶ Learn how to assign task configurations, timing, and priorities to resources
▶ Use the Sampling Trace function for diagnostic monitoring and troubleshooting
▶ Learn how to save, import and export project data
▶ Create process specific visualizations for monitoring and troubleshooting
▶ Network Installation
▶ Library Management
▶ Program Monitoring
▶ Data Back-up and Restore

TRAINING CLASS LENGTH: 3 Days

This three-day course is designed to give the IndraLogic Gen2 user the tools necessary to develop their processes in the IndraLogic PLCopen programming environment. Subjects covered include project structure, library management and creation, device specific target settings, device specific PLC Configurations, task configuration, variable types, field buses, Function Block Motion programming, etc. Programming languages covered include Structured Text, Instruction List, Ladder Diagram, Function Block Diagram, and Sequential Function Chart. IndraLogic Visualizations will be created to control program operation and to simulate an HMI interface.
Course #3120
IndraLogic Gen2 Advanced Programming

PREREQUISITES:
- Course #3110 IndraLogic Gen2 Basic Programming (or have extensive knowledge in the use of advanced PLC data types, and a working knowledge of Structured Text programming).
- If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraLogic Gen2 software installed on the computer. A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
- Engineering Technician
- Maintenance Technician
- Electrician Operator

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
- Understand PLCopen Logic specifications
- Understand PLCopen project components
- Create a project, and operate within that project environment
- Learn how to Use the Library Manager
- Write and debug programs in Structured Text
- Understand basic data types – DINT, BOOL, WORD, STRING, REAL, and more
- Understand and use various variable types – Global, System, and Local
- Understand Retain, Persistent, and Constant data
- Convert between the various data types
- Work with String Variables and Manipulate the String Data
- Apply and Monitor Indirect Addressing for data retrieval
- Create, Open, Append, and Close Files within the PLC Program
- Use the Sampling Trace function for diagnostic monitoring and troubleshooting
- Learn how to save, import and export project data
- Create process specific visualizations for monitoring and troubleshooting

TRAINING CLASS LENGTH: 2 Days

This two-day course is designed to give the experienced IndraLogic Gen2 user the tools necessary to further develop their processes. Using the exercises created in the #3110 class, the student will be adding additional data types to enhance process capabilities. The data types used will be Arrays, Data Structures, and Enumerations. The student will also be learning programming options for working with STRING and File data. The student will be creating one-, two-, and three-dimensional Arrays. These arrays will be populated and the data further processed using Data Structures. The programming language used will be Structured Text.
Course #4110
MTX Maintenance & Troubleshooting

PREREQUISITES:
▶ Course #3000 IndraLogic Software Overview OR Course #3010 IndraLogic Programming Basics OR Recorded Course #8010 IndraLogic Gen1 Basics.
▶ Course #1110 IndraDrive Basics OR Recorded Course #8003 IndraDrive Digital Servo Drive Basics is recommended, but not required.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $1,340.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Relate the connections on the MTX control to their application
▶ Create a new Project, or edit the various components in an existing Project
▶ Understand the various programming languages available in IndraLogic
▶ Install and/or modify existing I/O configurations
▶ Add peripheral devices to the system, as required
▶ Understand the relationships between the control and other connected devices
▶ Understand the various communication methods used to transfer data between the Motion Control, HMI, and Servo Drives
▶ Understand how servo drive motion is controlled and monitored
▶ Understand how to troubleshoot the system and its individual components
▶ Diagnostic Procedures
▶ IndraLogic PLC Programming
▶ Full Back-up and Restore

TRAINING CLASS LENGTH: 4 Days

This four-day course provides familiarization with the electrical connections, functions, and various operating modes of Bosch Rexroth’s IndraMotion series MTX control. This course also covers the use of IndraWorks™ and IndraLogic software for programming, parameterization, system and fault information, and system recognition of components. Training is enhanced through class exercises designed to re-enforce each aspect and function of the system.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #6100
PSI Welding Control

PREREQUISITES:
▷ This training class requires the student to bring their own computer for class use with BOS6000 software installed. A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▷ Engineering Technician
▷ Maintenance Technician
▷ Electrician Operator

TUITION: $1000.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▷ Identify the components of the welding system
▷ Communicate to the control using the BOS6000 software
▷ Access and manipulate parameters through the software
▷ Program the system using basic and advanced programming techniques and commands
▷ Relate process information obtained through the software and correlate to the process
▷ Relate diagnostic messages for proper troubleshooting solutions
▷ Safety Orientation
▷ System Overview
▷ Welding Basic
▷ PSI Inverter Hardware
▷ Maintenance and I/O Lab
▷ Operating and Programming Manual
▷ Troubleshooting Lab
▷ Fundamental Welding Principles

TRAINING CLASS LENGTH: 3 Days

This three-day course is designed for weld engineers, programmers and maintenance electricians. Theory of operation and function of major components are described. Electrical interface, diagnostics and practical troubleshooting are discussed. Hands on training is done using the PSI 6100 Welding Inverter simulator. The content includes backup and restore of the PSI 6100 Welding Inverter.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #7100
VI Composer with VCP Terminals

PREREQUISITES:
▶ A thorough understanding of the Microsoft Windows® computer operating system.
▶ Participation in one of the following Bosch Rexroth training courses is recommended, but not required:
  – #343 Visual Motion 11 with IndraLogic
  – #156 SYNAX 11, 12, & 13 with IndraLogic
  – #2100 MLC with L40 Control and IndraWorks (≤7) OR #2200 MLC with L25, L45, L65 Control and IndraWorks (≥10)
  – #3000 Basic IndraLogic OR #3010 IndraLogic Basics OR Recorded Course #8010 IndraLogic Gen1 Basics OR Online Course #83010 IndraLogic Gen1 Basics
▶ Students should have VI Composer (version 2) installed on their computers prior to attending class.
  A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $670.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Understand the operation of the various VCP operator panels
▶ Relate the connectors and connections on the VCP panels to their application
▶ Communicate to the VCP panels with VI Composer software
▶ Identify all of the VCP to PLC communication interfaces
▶ Understand data compatibility/structure with the different interfaces
▶ Understand the various screen types
▶ Create and modify standard and custom screens
▶ Create screens used to upload and download data between the VCP panel and IndraLogic PLC programs

TRAINING CLASS LENGTH: 2 Days

This two-day course of Bosch Rexroth’s VI Composer Software, version 2, for VCP operator terminals provides for familiarization with the software and the various operator panels and their hardware types. The course uses the VCP 25.2 touch-screen panel demonstration units. Discussion covers the various VCP hardware types, including interconnects and communication options. The student will have hands-on exercises to upload and download data (including recipes) to/from a PLC program to the VCP panel. The student will also create new screens for the upload/download of program variables, servo axis control, and diagnostic messages.
Course #7200
Bosch WinStudio Version 6

PREREQUISITES:
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth WinStudio software (version 6.5 or newer) installed on the computer. A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $1,675.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Creating and Opening Projects
▶ Working with Scripting Languages
▶ Creating Trends
▶ Configuring Events
▶ Communication Drivers
▶ Running Web Based Applications
▶ Working with ActiveX Objects
▶ Managing Applications Remotely
▶ HMI Hardware Overview
▶ Troubleshooting Application on HMI
▶ Configuring the Security System
▶ Alarm Worksheets and Graphic Displays
▶ OPC Communication
▶ Upload / Download to HMI

TRAINING CLASS LENGTH: 5 Days

This introductory training course is designed to help the student become familiar with the Bosch WinStudio software. In this class, you will learn all the basic functionality of Bosch WinStudio, including an overview of the underlying architecture. Student exercises are used to reinforce the skills learned and equip the student for real-world applications. Bosch Rexroth VEP 30.2 HMI panels will be used for the hardware portion of the class.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Course #7210
Bosch WinStudio Version 7

PREREQUISITES:
▶ If a student desires to use their own computer for the class, they must have a licensed copy of Bosch Rexroth WinStudio software (version 7.2 or newer) installed on the computer. A loaner laptop can be provided by Bosch Rexroth, if needed.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $1,675.00 per student (Lunch included)

WHAT YOU WILL LEARN:
▶ Bosch WinStudio Basics
▶ Creating and Opening Projects
▶ Create Demonstration Project
▶ Working with Scripting Languages
▶ Creating Trends
▶ Configuring Scheduler Worksheets
▶ Creating Recipes and Reports
▶ Configuring Events
▶ Configuring the Security System
▶ Communication Drivers
▶ OPC Communication
▶ Running Web Based Applications
▶ Working with ActiveX and .NET Controls
▶ HMI Hardware Overview
▶ Upload / Download to HMI

TRAINING CLASS LENGTH: 5 Days

This introductory training course is designed to help the student become familiar with the Bosch WinStudio software integrated into IndraWorks 10VRS. In this class, you will learn all the basic functionality of Bosch WinStudio, including an overview of the underlying architecture. Student exercises are used to reinforce the skills learned and equip the student for real-world applications. Bosch Rexroth VEP 30 HMI panels will be used for the hardware portion of the class.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Online Course #80150
Synax Versions 4–8 with SynTop Version 6

PREREQUISITES:
▶ The student must have a basic understanding of the Microsoft Windows™ computer operating system.
▶ The student should have participated in at least one of the Bosch Rexroth Digital Servo Drive training courses.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $1000.00 per student

WHAT YOU WILL LEARN:
▶ Introduction to Electronic Line Shafting (ELS)
▶ CLC / PPC Hardware
▶ Synax Basic Functions
▶ SynTop Software Tool
▶ Binary IO
▶ Jogging Functions
▶ Electronic Cams
▶ Parameters
▶ Motion Control Link
▶ Speed Switching and Position Signals

TRAINING CLASS LENGTH: 3 Days

This online course for the Bosch Rexroth’s Synax Motion Control System provides for familiarization with Bosch Rexroth Electronic Line Shafting technology. The student will gain a thorough understanding of this technology and how it applies to their manufacturing process. The functions of the CLC-D and PPC Synax Motion Control, along with configuration and process adaptation, will be covered using Bosch Rexroth SynTop software tool. The student will work through the complete configuration and operation of a system, including the use of real-time adaptation parameters, for the control of an Electronic Line Shafting process.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Online Course #81110
IndraDrive M/C Maintenance & Troubleshooting

PREREQUISITES: No prerequisites required

TARGET GROUP:
- Engineering Technician
- Maintenance Technician
- Electrician Operator

TUITION: $670.00 per student

WHAT YOU WILL LEARN:
- Relate the electrical connectors and connections in the system to their application
- Understand Power Section and Control Section differences
- Understand firmware and functional package differences
- Understand firmware compatibility with interfaces
- Understand the function and use of the MMC memory option
- Identify diagnostic messages and their types
- Identification of Bosch Rexroth servo and spindle motors
- Documentation Overview
- General System Overview
- HMV Power Supply Units
- HMS / HMD Modular Drive Units
- HCS Stand-alone Drive Units
- Drive Control Sections
- Drive Firmware and Functional Packages
- Drive Display and Messaging System
- Diagnostics
- Multi-media Memory Card (MMC)
- Drive Memory Areas
- Motors
- Feedback Devices

TRAINING CLASS TIME: 12 Hours

This online course of Bosch Rexroth’s IndraDrive servo drive provides basic familiarization with the drive system’s hardware and firmware. It covers the hardware basics, electrical connections, available firmware types, encoder types, and motor types. Drive diagnostic message types, displays and their functions are also covered.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Online Course #83010
IndraLogic Gen1 Basic Programming

**PREREQUISITES:** No prerequisites required

**TARGET GROUP:**
- Engineering Technician
- Maintenance Technician
- Electrician Operator

**TUITION:** $1000.00 per student

**WHAT YOU WILL LEARN:**
- Understand PLCopen Logic specifications
- Select the proper hardware Targets
- Create a project, and operate within that project environment
- Learn how to Use the Library Manager
- Write and debug programs in Structured Text, Function Block Diagram, Ladder Diagram, Instruction List, and Sequential Function Chart
- Understand basic data types – DINT, BOOL, WORD, STRING, REAL, and more
- Understand and use various variable types – Global, System, and Local
- Understand Retain, Persistent, and Constant data
- Learn how to assign Task configurations, timing, and priorities to resources
- Use the Sampling Trace function for diagnostic monitoring and troubleshooting
- Learn how to save, import and export project data

**TRAINING CLASS TIME:** 18 Hours

This 18 hour online course is designed to give the IndraLogic Gen1 user the tools necessary to develop their processes in the IndraLogic PLCopen programming environment. Subjects covered include project structure, library management and creation, task configuration, variable types, field buses, Function Block Motion programming, etc. Programming languages covered include Structured Text, Instruction List, Ladder Diagram, Function Block Diagram, and Sequential Function Chart. IndraLogic Visualizations will be available for upload to control program operation and to simulate an HMI interface.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Online Course #83110
IndraLogic Gen2 Basic

PREREQUISITES:
▶ Students must have knowledge of the function, operation and programming of PLCs.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $1000.00 per student

WHAT YOU WILL LEARN:
▶ Understand PLCopen Logic specifications
▶ Select the proper hardware targets
▶ Create a project, and operate within that project environment
▶ Learn how to use the Library Manager
▶ Write and debug programs in Structured Text, Function Block Diagram, Ladder Diagram, Instruction List, and Sequential Function Chart
▶ Understand basic data types – DINT, BOOL, WORD, STRING, REAL, and more
▶ Understand and use various variable types – Global, System, and Local
▶ Understand Retain, Persistent, and Constant data
▶ Learn how to assign task configurations, timing, and priorities to resources
▶ Use the Sampling Trace function for diagnostic monitoring and troubleshooting
▶ Learn how to save, import, and export project data

TRAINING CLASS TIME: 18 Hours

This 18 hour online course is designed to give the IndraLogic Gen2 user the tools necessary to develop their processes in the IndraLogic PLCopen programming environment. Subjects covered include project structure, library management and creation, task configuration, variable types, field buses, Function Block Motion programming, etc. Programming languages covered include Structured Text, Instruction List, Ladder Diagram, Function Block Diagram, and Sequential Function Chart. IndraLogic Visualizations will be available for upload to control program operation and to simulate an HMI interface.
Online Course #83120
IndraLogic Gen2 Advanced Programming

PREREQUISITES:
▶ #83010 Online IndraLogic Gen1 Basics (or have an extensive knowledge in the use of advanced PLC data types, and a working knowledge of Structured Text programming).

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $670.00 per student

WHAT YOU WILL LEARN:
▶ Accomplish Structure Text programming using WHILE, CASE, and DO Loops
▶ Understand advanced data types, i.e., Arrays, Enumerations and Data Structures
▶ Create and Populate Arrays
▶ Create and Manipulate Data in Data Structures
▶ Understand Arithmetic, Indirect Addressing, and Conversion functions
▶ Work with String Variables and Manipulate the String Data
▶ Apply and Monitor Indirect Addressing for data retrieval
▶ Create, Open, Append, and Close Files within the PLC Program

TRAINING CLASS TIME: 12 Hours

This 12 hour online course is designed to give the experienced IndraLogic Gen2 user the tools necessary to further develop their processes. Using the exercises created in the #83010 class, the student will be adding additional data types to enhance process capabilities. The data types used will be Arrays, Data Structures, and Enumerations. The student will also be learning programming options for working with STRING variables and File data. The student will be creating one-, two-, and three-dimensional Arrays. These arrays will be populated and the data further processed using Data Structures. The programming language used will be Structured Text.
Recorded Course #8003
IndraDrive Digital Servo Drive Basics

PREREQUISITES: No prerequisites required

TARGET GROUP:
- Engineering Technician
- Maintenance Technician
- Electrician Operator

TUITION: $345.00 per student

WHAT YOU WILL LEARN:
- Relate the electrical connectors and connections in the system to their application
- Understand Power Section and Control Section differences
- Understand firmware and functional package differences
- Understand firmware compatibility with interfaces
- Understand the function and use of the MMC memory option
- Identify diagnostic messages and their types
- Identification of Bosch Rexroth servo and spindle motors
- Documentation Overview
- General System Overview
- HMV Power Supply Units
- HMS / HMD Modular Drive Units
- HCS Stand-alone Drive Units
- Drive Control Sections
- Drive Firmware and Functional Packages
- Drive Display and Messaging System
- Diagnostics
- Multi-media Memory Card (MMC)
- Drive Memory Areas
- Motors
- Feedback Devices

TRAINING CLASS TIME: 2 Hours

This recorded course of Bosch Rexroth’s IndraDrive servo drive provides basic familiarization with the drive system’s hardware and firmware. It covers the hardware basics, electrical connections, available firmware types, encoder types, and motor types. Drive diagnostic message types, displays and their functions are also covered.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Recorded Course #8010
IndraLogic Basic

PREREQUISITES:
▶ Students must be experienced in Windows computer skills, and have fundamental knowledge in the programming and operation of PLCs.
▶ If a student desires to follow along on their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraLogic software installed on the computer.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $500.00 per student

WHAT YOU WILL LEARN:
▶ Understand the IEC 61131 PLCopen specification
▶ Select the proper hardware targets
▶ Create a project, and operate within that project environment
▶ Use the Library Manager
▶ Write and debug programs in Structured Text, Function Block Diagram, Ladder Diagram, Instruction List, Sequential Function Chart, and Continuous Function Chart
▶ Understand Basic IEC–Step–Action commands in Sequential Function Chart programming
▶ Understand basic data types – DINT, BOOL, WORD, STRING, REAL, and more
▶ Understand and use various variable types – Global, System, and Local
▶ Understand Retain, Persistent, and Constant variable data
▶ Understand program jumps and labels
▶ Build, download, run, stop, and edit programs
▶ Learn how to assign Task Configurations, timing, and priorities to resources
▶ Use the Sampling Trace function for diagnostic monitoring and troubleshooting
▶ Use the Alarms function
▶ Learn how to save, import, and export project data
▶ Create process specific visualizations for monitoring and troubleshooting

TRAINING CLASS TIME: 7 Hours

This recorded course centers on the creation of a complete PLC project. It is broken down into 5 Modules, designed to familiarize the new user to the IndraLogic PLCopen programming environment. Subjects include program elements, task configurations, data types, variable types, program debug, and program monitoring. With each succeeding module, different programs, function blocks, and visualization elements are created using all supported languages, i.e., Structured Text, Instruction List, Ladder Diagram, Function Block Diagram, Sequential Function Chart, and Continuous Function Chart. At the end of the course, the student will have created a fully functional and operational PLC project. This project will be run in a simulated environment that allows all programs to run on the student’s computer, without the need for any hardware devices.
Recorded Course #8020
IndraLogic Basic Programming

PREREQUISITES:
▶ Students must be experienced in Windows computer skills, and have fundamental knowledge in the programming and operation of PLCs.
▶ If a student desires to follow along on their own computer for the class, they must have a licensed copy of Bosch Rexroth IndraLogic software installed on the computer.

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $345.00 per student

WHAT YOU WILL LEARN:
▶ Understand the IEC 61131 PLCopen specification
▶ Understand the hardware targets
▶ Create a project, and operate within that project environment
▶ Use the Library Manager
▶ Write and debug programs in Structured Text, Function Block Diagram, Ladder Diagram, Instruction List, Sequential Function Chart, and Continuous Function Chart
▶ Understand Basic IEC–Step–Action commands in Sequential Function Chart programming
▶ Understand basic data types – DINT, BOOL, WORD, STRING, REAL, and more
▶ Understand and use various variable types – Global, System, and Local
▶ Understand Retain, Persistent, and Constant variable data
▶ Build, download, run, stop, and edit programs
▶ Learn how to assign Task Configurations, timing, and priorities to resources
▶ Learn how to save, import, and export project data
▶ Create process specific visualizations for monitoring and troubleshooting

TRAINING CLASS TIME: 2.25 Hours

This recorded course centers on the creation of a complete PLC project. It is broken down into 5 Modules, designed to familiarize the new user to the IndraLogic PLCopen programming environment. Subjects include program elements, task configurations, data types, variable types, program debug, and program monitoring. With each succeeding module, different programs, function blocks, and visualization elements are created using all supported languages, i.e., Structured Text, Ladder Diagram, Function Block Diagram, Sequential Function Chart, and Continuous Function Chart. At the end of the course, the student will have created a fully functional and operational PLC project. This project will be run in a simulated environment that allows all programs to run on the student’s computer, without the need for any hardware devices.
Recorded Course #8107
DIAx04 Digital Servo Drives

**PREREQUISITES:** No prerequisites required

**TARGET GROUP:**
- Engineering Technician
- Maintenance Technician
- Electrician Operator

**TUITION:** $345.00 per student

**WHAT YOU WILL LEARN:**
- SERVO Drive Principals
- Drive System Overview
- HVE/HVR Power Supplies
- Motors & Measuring Devices
- Diagnostics & Troubleshooting

**TRAINING CLASS TIME:** 2 Hours

This online course covers theory of operations, functions of major components, SERCOS and electrical interface, diagnostics and practical troubleshooting.
Recorded Course #8108
DKC Digital Servo Drive Basics

PREREQUISITES: No prerequisites required

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $345.00 per student

WHAT YOU WILL LEARN:
▶ Understand SERCOS Communications
▶ Relate the electrical connectors and connections on the drive to their application
▶ Identify different versions of firmware
▶ Understand firmware compatibility with interfaces
▶ Identification of Bosch Rexroth servo and spindle motors
▶ Identify diagnostic messages and their type

TRAINING CLASS TIME: 2 Hours

This recorded course of Bosch Rexroth’s DKC servo drive (Eco Drive) provides basic familiarization with the drive system’s hardware and firmware. It covers the hardware basics, electrical connections, available firmware types, encoder types, motor types, and the SERCOS interface. Drive diagnostic message types and their functions are also covered.
Recorded Course #8190
DriveTop Software

PREREQUISITES: No prerequisites required

TARGET GROUP:
- Engineering Technician
- Maintenance Technician
- Electrician Operator

TUITION: $345.00 per student

WHAT YOU WILL LEARN:
- DriveTop Software Overview
- Screen Navigation
- Main Menu Drop-down List Overview
- File Menu
- Setup Menu
- Drive Functions Menu
- Overview Menu
- Extras Menu
- Options Menu
- Help Menu
- DriveTop in the Visual Motion System

TRAINING CLASS TIME: 3 Hours

This recorded course covers the Rexroth DriveTop software commissioning and troubleshooting software tool. This course is applicable for all DriveTop software versions from 13VRS up to, and including, 16VRS. The software version used in this course is DriveTop 16V14. The purpose of this course is to aid the student in the use and navigation of the software for servo drive commissioning, monitoring, and to aid in troubleshooting their Rexroth digital servo drives. Each menu item, and how it relates to the servo drive is covered in detail.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Recorded Course #8211
IndraDrive Mi Gen 2 Digital Servo Drive Basics

PREREQUISITES: No prerequisites required

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $345.00 per student

WHAT YOU WILL LEARN:
▶ Relate the electrical connectors and connections in the system to their application
▶ Understand firmware and functional package differences
▶ Understand Firmware compatibility with interfaces
▶ Understand the function and use of the firmware module
▶ Identify diagnostic messages and their types
▶ Documentation Overview
▶ General System Overview
▶ Power Supply Units HMV & HCS
▶ KCU Interface Unit
▶ KSM & KMS Drive Units
▶ Drive Firmware and Functional Packages
▶ Drive Display and Messaging System

TRAINING CLASS TIME: 2 Hours

This recorded course of Bosch Rexroth’s IndraDrive Mi Gen 2 servo drive provides basic familiarization with the drive system’s hardware and firmware. It covers the hardware basics, electrical connections, firmware, and motor types. Drive diagnostic message types, displays and their functions are also covered.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com
Recorded Course #8343
Visual Motion Basics for Versions 10–11

PREREQUISITES: No prerequisites required

TARGET GROUP:
▶ Engineering Technician
▶ Maintenance Technician
▶ Electrician Operator

TUITION: $345.00 per student

WHAT YOU WILL LEARN:
▶ Understand the differences / similarities between the Visual Motion 10 & 11 systems
▶ Understand SERCOS Communications
▶ Identify the different hardware devices
▶ Understand the different methods of communication available
▶ Understand the different types of motion available
▶ Configure data transfer between motion control and PLC
▶ Understand and view registers
▶ Understand the components that make up the project
▶ Configure IO hardware devices
▶ Identify the different types of parameters in the system
▶ Use the Data Editor utility to view project data
▶ Archive / Restore project data
▶ PPC System Architecture & Hardware
▶ RECO IO Hardware
▶ Motion Capabilities

TRAINING CLASS TIME: 2 Hours

This recorded course about Bosch Rexroth’s Visual Motion control system provides basic familiarization with the system hardware and basic functionality. It covers the hardware basics, introduction to the Visual Motion and IndraLogic software, and the interrelationship between the PLC and the motion control.

For more information contact us at: 1(847) 645-4061
For immediate assistance call: 1-800-REXROTH (24 Hours/Day)
Full course agenda click here: Bosch Rexroth Training Calendar
https://boschrexroth-us-training.configio.com